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Abstract. This document describes NGUI, the NEWFIRM graphical user interface, for
generating observing scripts. It is assumed that the observer is familiar with the allowed
NEWFIRM observing recipes.
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1. Installation

To run NGUI, you must have Tcl/tk installed on your system. The software has been tested under
various flavors of Linux (CentOS 4, Fedora Core 5) and Mac OS X (10.4 Tiger, 10.5 Leopard).
There is no Windows version.

To install the software, unpack the tarball into a known directory and edit the ngui.cshrc file
to reflect the ‘home’ location. By default, NGUI HOME is /home/ngui:

% cd /home
% gzip -cd ngui.tgz | tar xvf -
To start the software, source the C-shell script:
% source $NGUI HOME/etc/ngui.cshrc
% ngui &
To exit the software, select ‘Exit’ within the File menu and be prompted, or click on the × in

the upper left/right hand corner of the application.
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2. Start Me Up!

Figure 1.: NGUI Project Parameters Screen

When started, you will see the default project screen, shown in figure 1, and you should edit
and save these values. These edits are saved in ∼/.ngui for future reference. At the telescope, this
file is sent to the KTM to put the appropriate observing staff keywords in the meta-data.

Once the project parameters have been saved, the main interface shown in figure 2 will appear.
Note the color-coded command buttons to reflect differing functionality within the interface.

The interface is made up of 4 parts:

Menu Bar This consists of the File menu, shown in Figure 3, the Options menu (presently empty)
and the Help menu (which provides the software revision number).

Text Pane The text pane reports various activity when generating scripts. Normally, these mes-
sages are informational but you will sometimes see a red ‘ERROR’ message appear—please
take note and corrective action. For example, an incorrectly formatted RA,Dec,E poch will
result in an error (which in this case can be ignored!). The script will still be written but
offending lines will be commented out.

Output Modifiers This line allows the user to enable or disable various outputs in the resulting
scripts. When enabled these buttons:

• ERROR Cmnds: insert error checking into the output script so that the script aborts
when something goes wrong. NB: This is something you always want to do so disable
it at your own risk.

• BIAS Cmnds: insert commands to enable bias voltages. At present, it is disabled be-
cause you will bias the arrays manually whilst at the telescope. NB: Do not enable this
feature unless instructed to do so by a scientist/engineer.

• FILTER Cmnds: insert filter commands into the output scripts. It is there for lab check-
ing when the filter wheel may be physically out of action. NB: This is something you
always want to do so disable it at your own risk.
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Figure 2.: NGUI Main Interface

DRAFT



4 P. N. Daly

Figure 3.: NGUI File Menu Screen

• GUIDER Cmnds: does nothing. The interaction betwen NGUI and guide star selec-
tion/operation is currently under review.

• SLEW Cmnds: insert telescope slew commands into the output files. At present, it is
disabled because of safety issues. Even if enabled, these commands are not currently
written to the script so make sure you bring your target lists with you!

Two other options also exist:

• Dome Flat Lamp: indicates the status of the dome flat lamp which is not under obser-
vatory software control (so this flag makes the FITS meta-data correct). When enabled
the dome flat lamp is assumed to be on (and vice-versa). This flag is not used for a
dome flat sequence.

• Allow Brownian Motion: for random dither or map patterns, this flag enables or disables
the Brownian motion effect. If enabled, a series of n observations results in a random
walk of

√
n positions away from the origin. If disabled—the default—the telescope

offsets are randomly-centred around the nominal home position.

Command Buttons These buttons define the various observing recipes allowed by the NEWFIRM
observation control system (see [1]).

3. A Tour Of The Widgets

Each command button produces a new top-level window that consists of only those widgets re-
quired to create the output script. There are 6 main areas (script, observation, monsoon, telescope,
dither and map) as described below.

At the bottom of each window are command buttons:

• OK: grabs various widget parameters and creates the script in $NGUI EXEC. The user is
prompted if the filename already exists.

• What’s This: a simple help file is displayed as an aide memoire for the given recipe.
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• Cancel: dismisses the window with no action taken and no script generated.

3.1. SCRIPT CONFIGURATION

Figure 4.: NGUI Script Configuration Frame

Object Name a descriptive name meaningful to the observer which becomes the OBJECT FITS
keyword.

Script Name the name by which the script is stored in the $NGUI EXEC directory. Spaces are
replaced by underscores.

3.2. OBSERVATION CONFIGURATION

Figure 5.: NGUI Observation Configuration Frame

NumObs The number of observations to take at each telescope pointing.

SkyMod The sky modulus is the number of modulo frames to skip when going to sky in the
QuickMapWithSky and ModMapRich recipes. If set to 1, the script will take a sky frame after
every object frame and if set to, say, 3 the sky frame becomes every third frame.

Filter The desired filter. In some cases various filters may be disabled. Note that the DomeFlatSe-
quence recipe is different and is explained in § 3.7.

3.3. MONSOON CONFIGURATION

Figure 6.: NGUI Monsoon Configuration Frame

intTime(sec) the requested integration time per observation, or per coadd if coadds>1.

coadds the requested number of coadds per observation within the MONSOON system.

bias(mV) the requested bias voltage. NEWFIRM is currently configured for 400mV bias only so
the other options should be ignored. This item is ignored if ‘ERROR Cmnds’ is disabled.

fSamples the requested number of Fowler samples.

digAvgs the requested number of digital averages. Note that the DomeFlatSequence recipe is
different and is explained in § 3.7.
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Figure 7.: NGUI Telescope Configuration Frame

3.4. TELESCOPE CONFIGURATION
POSITION 1 the telescope position which can be one of several alternates:

• Zenith: move the telescope to zenith;
• O-Sun: move the telescope to the lowest elevation opposite the Solar position (usually

the sunset point);
• DFS: move the telescope to the dome flat screen (a.k.a. the great, white spot);
• CoOrd: if selected the RA, Dec, Epoch entry widgets become enabled and the user may

enter appropriate parameters. If the co-ordinates do not parse correctly, and ERROR is
issued to the text pane.

• RA: if enabled the RA for the requested object.
• Dec: if enabled the Dec for the requested object.
• Epoch: if enabled the Epoch for the requested object.

OFFSET the offsets for sky frames in various recipes:

• RA(”): relative offset for RA in seconds of arc;
• Dec(”): relative offset for Dec in seconds of arc;

to sky.

FOCUS the parameters associated with executing a Focus script (only):

• Start Focus (µm): start focus position.
• Step Size (µm): the step size to increment/decrement between focus observations.
• # Focus Steps: the number of focus positions to take.

3.5. DITHER CONFIGURATION

Figure 8.: NGUI Dither Configuration Frame

RA(”) the RA steps size, if appropriate, in arcseconds for the given pattern. For the random
pattern, the upper/lower bounds of the walk, in RA, are set to +/- RA size;

Dec(”) the Dec steps size, if appropriate, in arcseconds for the given pattern. For the random
pattern, the upper/lower bounds of the walk, in Dec, are set to +/- Dec size;

1Note: for safety reasons, telescope slews are disabled so these buttons, in effect, do nothing!
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Iterations the number of times the pattern should be executed.

Settle(sec) the number of seconds to allow for telescope settling after an offset when guiding—can
be set to 0.

GEOMETRY: the dither geometry as follows:

• 5PX: positions are SE, NE, NW, SW and home in diamond pattern with data taken at
every pointing.

• 4Q: positions are the centres of each array (quadrant);
• Random: positions are generated by the Tcl/tk rand() function within the RA, Dec

bounds specified and allowing (or not) for Brownian motion. If selected, a new widgets
appears—labelled ‘# Random Steps’—allowing the user to specify the total number of
pointings.

• RAxDec: an RA x Dec grid of positions generated so that the object is always centred
in the grid. If selected, 2 new widgets appear—labelled ‘# RA Steps’ and ‘# Dec Steps’
respectively—allowing the user to specify the exact grid pattern required.

• From File: pops-in another widget allowing the user to specify a file containing RA,
Dec offsets in arcseconds, 1 pair per line, separated by whitespace. If selected, a new
widgets appear—labelled ‘Filename’—allowing the user to specify the full path to the
offset file.

NB: All patterns return to the ’local’ field center when done.

3.6. MAP CONFIGURATION

Figure 9.: NGUI Map Configuration Frame

RA(”) the RA steps size, if appropriate, in arcseconds for the given pattern. For the random
pattern, the upper/lower bounds of the walk, in RA, are set to +/- RA size;

Dec(”) the Dec steps size, if appropriate, in arcseconds for the given pattern. For the random
pattern, the upper/lower bounds of the walk, in Dec, are set to +/- Dec size;

Iterations the number of times the pattern should be executed.

Guider Wait? a true or false flag which, if true, pauses the script whilst a new guide star is se-
lected. The script only continues when the observer responds to the prompt.

GEOMETRY: the dither geometry as follows:

• 5PX: positions are SE, NE, NW, SW and home in diamond pattern with data taken at
every pointing.

• 4Q: positions are the centres of each array (quadrant);
• Random: positions are generated by the Tcl/tk rand() function within the RA, Dec

bounds specified and allowing (or not) for Brownian motion. If selected, a new widgets
appears—labelled ‘# Random Steps’—allowing the user to specify the total number of
pointings.
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• RAxDec: an RA x Dec grid of positions generated so that the object is always centred
in the grid. If selected, 2 new widgets appear—labelled ‘# RA Steps’ and ‘# Dec Steps’
respectively—allowing the user to specify the exact grid pattern required.

• From File: pops-in another widget allowing the user to specify a file containing RA,
Dec offsets in arcseconds, 1 pair per line, separated by whitespace. If selected, a new
widgets appear—labelled ‘Filename’—allowing the user to specify the full path to the
offset file.

NB: All patterns return to the ’local’ field center when done.

3.7. Dome Flat Sequence

Figure 10.: NGUI DomeFlatSequence Recipe Window

The DomeFlatSequence recipe window is shown in the figure and differs because the filter se-
lection contains checkbuttons and not radiobuttons. The difference is that radiobuttons are mutually
exclusive (i.e., you can only choose 1 at a time) whereas checkbuttons allow multiple selections.
When checked, the corresponding Monsoon configuration widget for that filter is enabled and a
script is created that sequences through the filters in a known order. In the example figure, dome
flats would be taken in the following filters: J, K, F1063W, J2Yale and H1Yale.

NB: the dome flat sequence script is highly interactive requiring adjusting the dome flat lamp
at various points during the execution of the script. When at the telescope, do not leave the script
running and walk away!

4. Document Revision History

19 December 2007, PND: Original version. 01 April 2008, PND: Conforms to new NGUI after
observer feedback.

Acknowledgments. PND would like to thank R. Probst, MḊickinson et al for useful discus-
sions.
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